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Introduction 
This document specifies the steps needed to create a Path database from an individual VDDT model 
database and integrating these models with the spatial data relevant to the geographic modeling region.  
This entire process is referred to as “data rollup” or “rollup” in this document. The modeling packages 
used for this were created by the Integrated Landscape Assessment Project at the Oregon State 
University-Portland State University’s Institute for Natural Resources (ILAP: 
http://oregonstate.edu/inr/ilap). There is no warranty or support available for these models, spatial 
data or the use of this document. 

Data and software used in ILAP State-and-Transition modeling 
External software: 

• VDDT 6.0.25 (http://essa.com/ ) 
• Path 3.0 to Path 3.1 (ESSA technologies, at:  http://www.apexrms.com/path ) 
• ArcGIS 9.3 with spatial analyst extension (ESRI: http://www.esri.com/ ) 
• R-language and free software   (http://www.r-project.org/ ) 

ILAP models, data and tools (on FTP site: ftp://131.252.97.79/ ): 

• Pre-Rollup Modeling Package 
o VDDT and Path model databases (without spatial information) 

 Multiplier files used by models 
• Transition multipliers 
• MCM multipliers (temporal multipliers) 

o Template folders 
o Documentation 

• Tools Package 
o Data rollup tools 

 Data Rollup and Query Tool (DRQT v3.2) 
 GIS tool v.3.0.1 
 Template rollup database 
 DRQT and GIS Tool Documentation 
 GIS temporary output folder 

o Lumping tool (R-code: LumpStrata_0.10.zip) 
o GIP tool 
o Summarization tool (R-code package: SumPath_0.10.zip) 
o Summarization graphing tool 

• GIS data (Individual model region’s file geodatabase) 

Figure: Files to download from the ILAP FTP site 

Pre-Rollup Modeling Package Tools Package Contents of a GIS file 

http://oregonstate.edu/inr/ilap�
http://essa.com/�
http://www.apexrms.com/path�
http://www.esri.com/�
http://www.r-project.org/�
ftp://131.252.97.79/�
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Directory structure for rollup and modeling on your computer 
The folder and pathways names must not contain spaces. For example, the typical Microsoft’s “My 
Documents” location is not acceptable to some of the tools used in the rollup process.  There also 
appears to be a limitation in the length of characters in the full path to your modeling directory. This is 
most likely related to the length of the pathway to the ArcInfo directory that is created as part of the 
rollup process by the GIS tool. To avoid problems, the modeling folder name should be short and placed 
close to the root directory of your hard drive so that the number of characters should not exceed 65 for 
the entire pathway, including the name of your modeling folder (e.g. 
“D:\ILAP\Modeling\WNE_Forest_Modeling” is OK but 
“D:\ILAP\Modeling\Folder1\Folder2\Folder3\Folder4\WNE_Forest_Modeling” may be too long). 
Whatever your choice, you will want to organize your directories in such a way that you can find files 
easily and track all the steps in the modeling and rollup processes. The steps in this document refer to 
the folder, file and field names that are shown above and it is recommended that you maintain these 
names and directory structure until you are more familiar with the rollup process. The Northeast 
Washington modeling region (WNE) for forest models and the Southeast Oregon (OSE) for arid models 
are provided as tutorial packages on the FTP site. In this document, I use the WNE models and the date 
convention,”YYYYMMDD”, as examples in these steps.  

 

Copy data from ILAP FTP site  
1. Use your web browser to navigate to the ILAP FTP site: ftp://131.252.97.79/ and download the 

following: 
a. Download a regional, pre-rollup modeling package for your project area 

(ILAP/Modeling/PreRollupModelingPackages/) and unzip to a location on your 
computer. 

ftp://131.252.97.79/�
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b. Download the corresponding region’s GIS data (ILAP/GIS/Rollup_GDBs/), unzip and 
install to the GIS_Data folder in the modeling package  

c. Download the tools package (ILAP/Modeling/Tools/), unzip and install to the Tools 
folder in the modeling package 

2. For tutorial only: Instead of step 1, download one of the two tutorial packages 
ILAP/Modeling/Pre-RollupModelingPackages/Tutorial_WNE_Forest_Modeling.zip or 
Tutorial_OSE_Arid_modeling.zip), which contains all 3 packages in one folder. This tutorial data 
limits the data to just wo watersheds for WNE forests or one watershed for OSE arid models. By 
using the tutorial package, the processing time for each step is reduced considerably. This 
package also contains sample results (databases and models) that have been created after the 
completion of different stages of the tutorial.  
 

Model databases in the pre-rollup modeling packages 
These databases only contain the VDDT and Path versions of regional ILAP models. Neither of these 
databases contain the spatial information necessary for running these models for an actual landscape. If 
users desire to use the landscape-populated databases used by ILAP to create results, they should refer 
to the rollout packages that are also found on the FTP site. Otherwise, the user should proceed with 
building spatially-populated Path databases by following the steps in this document. 

 

Tutorial assumptions and modeling rollup schematic  
This tutorial begins with the assumption that the user must build a landscape-ready, Path database from 
a VDDT database and GIS data. The term “Db” will be used throughout this document to refer to a 
database. An advanced tutorial (not part of this document but will be downloadable from the same 
location) will provide instructions on creating a landscape-ready Path database from an existing Path Db. 
This advanced tutorial will also discuss the development of a “relative area” Path database to facilitate 
testing and modifications of Path models’ states, transitions and multipliers. A schematic of the rollup 
instructions provided in this document (i.e. assuming you are starting from VDDT) is shown below. 
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Compare PVT spatial data with models in VDDT 
The models in the database must match the PVT spatial data. Compare and modify by: 

1. In MS Access, open the VDDT model database (Models folder), then open the ‘Project’ table. 
2. Open ArcMap, add the PVT data, open its table and compare against the model table: 

a. The same PVT data is used by both Forest and Arid models, so you need to set the mask 
values to match your model database. Change the values in the mask field to “1” for all 
models that you want to rollup into Path. The number of PVTs that have a “1” should be 
the same number as (or less than) the number of models in your VDDT Db.  

b. The 7-digit PVT codes (e.g. “WNE_fpd”) must match the model names in the model 
database. 

 

Optional: Import models or modify an existing VDDT database  
Models and GIS databases for the ILAP project are divided into geographic modeling regions. If your 
region crosses over ILAP modeling regions, you will need to import new models into your Db and also 
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modify your existing spatial data. It is beyond the scope of this document to instruct the user on all the 
possible alterations to an existing ILAP model database but some limited instructions are below: 

1. Import additional models into the region’s already existing VDDT Db 
a. Populate this Db with models from another VDDT Db: Open Db in VDDT, then choose 

File->Import->Project->mdb 
2. Modify existing models in VDDT 

a. Replace the 3-digit prefix in each of the models with any prefix that meaningfully 
matches your region or project name and matches the PVT codes in your GIS data. For 
example, you could change “WNE_fpd” (ILAP’s Washington Northeast model region’s 
dry pine model) to “CNF_fpd” for a dry pine model  for the Colville National Forest. 

b. Although there are many changes that can be made to the models (new states, 
transitions, probabilities, etc), these changes are beyond the scope of this document. 
Users should refer to the ESSA website for detailed instructions on model modifications 
(http://essa.com/tools/VDDT/ ). 

 

Optional: Modify GIS data to suit your project needs 
The PVT layer specifies which models are available in an ILAP model region and the geographic extent 
and area of each model. Modify the GIS data to suit your project needs. It is beyond the scope of this 
document to instruct the user on all the possible alterations to the existing ILAP model region data. Any 
new data must have the same resolution, snap, extent and coordinate system as the existing data. Some 
possible alterations might be: 

1. Ignore watershed boundaries: reclassify all raster values in the existing HUC layer as 999 (any 3 
digits) and name this new layer as “HUCS_NoData” 

2. Use different ownership group: Reclassify a copy of the existing OwnerAlloc layer or add a new 
ownership layer to the file geodatabase. This new layer should follow the same field naming and 
data type conventions to avoid errors in the rollup process. For example, you should use the 
field name “Owner_Id”, with a String/text data type, and populate with codes that are only 2 
characters in length (letters or numbers are OK). You can create an additional field or a separate 
lookup table to keep track of what each code means and how they match your particular 
ownership-management groups. 

3. Mask layer: The existing mask allows the rollup process to ignore areas identified by the GAP 
coverage as wetlands, barren, water, urban, agricultural, etc. If some of these land use/ land 
cover types are needed, then you will need to create and use a new mask layer. 

 

Import GIS data into the data rollup database 
This step will populate tables in the data rollup database with information from the GIS data.  

http://essa.com/tools/VDDT/�
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1. Copy and rename the data rollup database (Tools/DataRollup_Tools/DataRollup_Database/) 
into the same folder and rename with a region prefix and a date suffix (e.g. “WNE_DataRollup_ 
YYYYMMDD.mdb”). Because this tool overwrites tables in the rollup database, copying and 
renaming the database with a date suffix will help to keep track of multiple rollup iterations. 

2. Using the GIS tool to populate the rollup database:  
a. Open ArcMap and add the required GIS layers from your file geodatabase 

(ModelinPackage/GIS_Data/): PVT (potential vegetation),HUC (watersheds),Ownership-
Allocation, GNN (Current vegetation), RegionMask 

b. If the Spatial Analyst extension is not already active, from the menu, select 
Tools>Extensions>Spatial Analyst (in ArcGis 10, this is Customize>Extensions>Spatial 
Analyst) 

c. Add the Data Rollup Toolbox (Data_RollupTools/GIS_RollupTool/) to ArcMap’s 
ArcToolBox 

d. Open the script (with the same name) inside this toolbox (figure below) 

 

e. Populate the tool’s form with the GIS data (figure below) 
i. Drag-and-drop the GIS layers into the corresponding boxes in the tool form (or 

browse to each layer in the file geodatabase using the open-folder icon) 
ii. For Coordinate System, import from any one of these GIS layers 

iii. For the temporary GIS output directory, browse for and select the 
Tools\DataRollup_Tools\GIS_TempOutput  folder (optionally, you can create a 
new folder in any location with a name of your choosing , such as 
“GISRollupOutput_YYYYMMDD”. This would be helpful if you need to track 
multiple versions of the rollup and don’t want to overwrite data in the default 
folder.) 

1. An ArcInfo workspace will automatically be created in this folder during 
the rollup process 

iv. For the Rollup Database, browse to the database renamed in step 1 above. 
v. Run the Tool and once the GIS rollup process has completed successfully,close 

ArcMap (optionally, save the mxd file to your GIS_Data folder). Depending on 
your data, this tool may take several minutes to more than hour. For the tutorial 
data, this should be less than 10 minutes. 
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vi. You may confirm that this tool was successful by opening the data rollup 
database. There will now be values from your GIS data in the tables: 
rollup_final; ownerall_final; pvt_final; huc_5_final; cover_final and 
structure_final tables.  

vii. For future rollups, you may also re-use an existing, populated  rollup database 
(rather than the Template_Rollup provided in these packages). The values in the 
tables from previous rollups will simply be overwritten. 

Figure: The GIS Data Rollup Tool with example inputs 

 

 

Create a Cover Type crosswalk (Region 6 forests only) 
A crosswalk has already been built for each model region, which matches the current vegetation cover 
types ((GNN layer, ForTypeIV field) that are found within each PVT with the cover types for each VDDT 
model (CoverAbbr in the crosswalk). If no changes are made to the models or the spatial data (e.g. 
adding new cover types or new models), then add the existing crosswalk to the rollup Db: 

1. Open the data rollup Db ( Tools/DataDataRollup_Tools/DataRollup_Database/) 
2. Import the Excel file (ModelingPackage/Documents/) 
3. Confirm that 3 field names are exactly specified as “PVT”, “ForTypeIV” and “CoverAbbr” (figure 

below  

Figure: PVT-ForTypIV-Cover Crosswalk example 
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Otherwise, use the auxillary tool found within the DRQT tool to create a new crosswalk. 

1. Open the data rollup tool, “DRQT” ( Tools/DataDataRollup_Tools/DRQT/) 
2. Select the “File” menu option at the top of the tool, then select ‘Create ForTypIV to Cover table’ 

(figure below) 
3. For the 1st box, browse for and select the data rollup Db ( 

Tools/DataDataRollup_Tools/DataRollup_Database/) 
4. From the dropdown list, select PVT code 
5. Specify a meaningful name for this table. For example, 

“WNE_CurrentCoverType_to_ModelCoverType_Crosswalk” 
6. Select continue to create a template table, which is added to the data rollup Db 
7. Close the auxillary tool and DRQT 
8. Open the data rollup tool Db, then open the table you just created 
9. For each PVT, assign a model cover type that most closely matches the current veg cover types 

(ForTypIV)  

Additional notes on building this new crosswalk: 

a. It may be easier to copy this table to Excel, filling it out and then copying back to the 
data rollup Db 

b. “REMNANT” (<10% tree cover) and blank records (1 of each for each PVT) should be 
reclassified into the early-successional cover type.  

Note:  The assumption here is that the reproducing species is the dominant one in these 
cells, rather than the species that might be standing and forming the sparse canopy 
cover. For example, in the mountain hemlock model (OEC_fmh), one could assume that 
a remnant has been created by a wildfire disturbance and that the standing trees are 
those that are most resistant to wildfire, in this case, mountain hemlock. Also, maturing 
and mature lodgepole pine (the early successional species) would have been killed 
during the fire that produced the remnant. However, given the rule of thumb, the 
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correct cover type call is lodgepole pine because we would expect it to be regenerating 
in the site more successfully than the late seral species, mtn. hemlock.  

Figure: Auxillary tool for creating a template crosswalk 

 

 

Lumping Strata (optional) 
ILAP uses the unique combination of 3 data layers (PVT, Ownership-Allocation and Watersheds) to 
create modeling strata.  This may create many strata which are regarded as “too small”. ILAP uses a 
threshold of <1,000 acres for distinguishing these small strata. Problems with modeling these small 
strata are: 

• The precision of these strata is greater than the spatial accuracy of the underlying data layers, 
particularly the current and potential vegetation data. 

• Low probability transitions may not occur, so states that would normally be represented on the 
landscape will not be modeled. ILAP refers to this as “unstable results” 

• Path modeling software (versions 3.0 and 3.1) has an internal default minimum area (“total 
number of simulation cells” >1). If a modeled stratum is less than this, the software will still 
model the stratum but it will default to 100 cells. If the user chooses not to aggregate strata 
with our lumping tool then they should be aware that some of their area results will be 
simulated rather than actual. 
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ILAP uses a tool that reassigns pixels from a small stratum (<1,000 acres) to a larger, similar stratum 
within the same HUC.  This reassignment is based on similarities in PVT (using elevation, moisture 
regimes, species composition and ownership-allocation). When there is no reasonable reassignment, 
any remaining, small strata are excluded from the rollup into the Path Db. For instructions on lumping, 
see the Appendix-Advanced section at the end of this document. 

 

Run the DRQT tool 
The Data Rollup Query Tool (DRQT) performs several operations on the data generated from the GIS tool 
and contained in the rollup database. First it ensures that the set of PVTs in the GIS data contain a match 
in the VDDT model database. Next, DRQT joins all of the GIS attribute data so that all pixels have all 
input layer attributes.  It then applies cover and structure crosswalks to the current vegetation classes 
(defined in the current vegetation (GNN) layer). The newly classified state classes are compared to those 
that exist in the VDDT model database.  For Oregon and Washington (Region 6) forests, if no such state 
class exists, structural attributes are subjected to an iterative reclassification scheme until all pixels are 
assigned to a state class that exists in the VDDT model database. Pixels are then summarized by 
modeling strata and VDDT state class. 

1. Open the data rollup tool, “DRQT” ( Tools/DataDataRollup_Tools/DRQT_Tool/) 
2. In the 1st box, browse for and select your data rollup tool DB ( 

Tools/DataDataRollup_Tools/DataRollup_Database/) 
3. From the dropdown lists under “Select Appropriate Fields”, select the PVT field (“PVTCode”), the 

HUC field (“Value_”) and the Owner field (“Owner_ID”). Note: these could be named something 
else. PVT field should be 7 characters, HUC should be 3 digit number, owner-Management 
should be 2 characters 

4. For the Modeling Region radio buttons, select your model region (and if R6 forest, select the 
CurrentCover-to-ModelCover crosswalk that should now be in your data rollup Db) 

5. Under  the “Select model database for your data region option”, ‘VDDT DB’ should be checked 
by default.  If you are interested in rolling up data from a Path DB, refer to the Path DB rollup 
section in the advanced tutorial . 

6. Under “Select File”, browse for and select your VDDT Db (ModelingPackage/Models/) 
7. Do not check the “aggregation” box unless you have lumped your strata (Instructions for this 

lumping process are in the appendix at the end of this document) 
8. Select “Run Data Rollup”. If there are errors, see the Troubleshooting section at the end of this 

document in the Appendix. 
9. Confirm that the tool was successful by opening the rollup Db and making sure the following 

tables are populated with information from the models you are running: CoverType,  StateClass,  
StructuralStage,  tmp_importedICs, ztbl_initialConditionsRasterTable,  ztbl_RawData,  
ztbl_reclassifiedSCs  (and ztbl_StrataAggregation if you used the lumping process and checked 
the aggregation option in DRQT) 

10. Close DRQT 
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Figure: The Data Rollup Query Tool (DRQT) 

 

 

Create a Transitions Multipliers table 
Transition multipliers can be used to adjust the probability of a transition occurring, ranging from 
deactivating the transition completely (multiplier of zero) to decreasing or increasing a transition rate by 
using a number between zero and one or greater than one, respectively. For the ILAP default “No 
Management” scenario, all management transitions were deactivated using a multiplier of zero. 
However, for many management situations, numbers between zero and to greater than one should be 
used to adjust the transition probability of a management event. The value of “1” should be used to 
simply “turn on” a transition with the same probability that is specified in the model. A transition 
multipliers table has been created for each model region package, follow the steps below to include this 
in your rollup database. If the Transition Multipliers is missing follow the steps in the Appendix to create 
a new table. 
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1. Open the data rollup Db in Microsoft Access ( 
Tools/DataDataRollup_Tools/DataRollup_Database/<Your rollup database name>) 

2. Import the Transition Multipliers Excel table (Models/Multipliers). The Transition Multipliers 
table must have the following structure: 

a. ID – a series of numbers from 1 to n+1 which span the entire list of transitions by PVT. (if 
not already existing, this can be added when you import the table from Excel back into 
the rollup Db by allowing Access to add a primary key) 

b. PVT – The PVT name.  Each PVT name will be repeated in the table based on the number 
of probabilistic transitions in the model.  Example:  There are seven transitions in the 
oak-pine model in the CWLA (Y301op).  Y301op will therefore be listed seven times. 

c. Transition Type – the name of each transition found in every PVT in the modeling 
region.   Each transition type is unique within a PVT. This field name must have a space 
between the words “Transition” and “Type”. 

d. Management Codes – The remaining columns will contain two character codes for every 
ownership/allocation found within the modeling region pre-lumping.  The names and 
number of columns (i.e. # of codes) should correspond to the owner-management codes 
in the “owner_all” table in the Rollup Tool database. 

e. Name the table TransitionMultipliers, or any other name that does not contain spaces 

If the mask or spatial extent of your region is not the same as the ILAP region’s GIS data, you will need to 
make sure the ownership-allocation fields exactly match the name and number of categories in the GIS 
data (as imported into the data rollup Db from the GIS tool). 

1. Compare the “TransitionMultipliers” table with the ownall_final table (in the rollup database) 
2. If an ownership  type does not exist  in ownall_final table , then delete extra ownership field 

from the TransitionMultipliers table 
3. If an ownership  type exists  in ownall_final table  and is not in the TransitionMultipliers table, 

then add this type as a new field  
f. Populate the new field with values (1s and 0s or other numbers) 

Figure.  Example of the TransitionsMultiplier Table 
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Monte Carlo Multipliers (MCM) file 
VDDT and Path provide the capacity to incorporate stochasticity in model runs, such as yearly variation 
in the amount of area burned or onset and duration of insect outbreaks. To incorporate year-to-year 
variation, we created a stream of randomly generated sequences of multipliers that are applied to 
individual model simulations and select transition types. These sequences are called Monte Carlo 
multipliers and are generated using the MCM builder tool in VDDT for the desired number of model 
simulations. An MCM file has been created for each model region package (Models/Multipliers). You will 
be specifying the location of this file inside the Path Db in the next section of this document. If you 
intend to run models longer than 300 years (or 150yrs for arid models) or want to change the variation 
of the transitions in this file or want to add new transitions to this file, you will need to use the MCM 
Builder (Models/Multipliers /Build_MCM.exe) and the auxillary MCM files also found in this folder. Users 
should refer to VDDT documentation for more details on constructing a new MCM file. 

 

Template Path database 
The template Path Db contains the models, imported from VDDT, folders used by the ILAP modeling 
process, and parameters specified in the Common scenario. Such a database has already been created 
for each region’s modeling package and is available in the Model folder with a prefix of 
“TemplateForPath_”. This database is then used to create a new Path database with multiple modeling 
strata and spatial information for each state within each stratum. If this template database is available, 
you may skip to the next section titled “Get into Path: The GIP Tool”. If this template Db is not available 
or your models have been modified (i.e. new models added or new states added to a model) you will 
need to create a new template by following the steps below. For questions about how to create new 
folders and navigate in Path, refer to the Path help file. 

1. Open Path software 
2. Import VDDT models:  

a. Select “File”->”New”->”Project from VDDT” 
b. Browse for and select your VDDT Db 
c. Save a new Path Db with a “TemplateForPath” prefix (e.g.  

“TemplateForPath_WNE_Path_Forest_YYYYMMDD”) into your Model folder. This will be 
used to create another Path DB in the GIP tool. 

d. Check the box, “Use VDDT definition Codes on Import” 
e. Select “Create New” to create this template Db 
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3. A scenario will be added to the project explorer with the name of your imported VDDT model 
database. Rename this scenario to “Common”. (Figures below) 

4. Add the following sub-folders to the “User Scenarios” folder: 
a. Common  
b. Multipliers   
c. Runs 

5. Drag the default scenario (which will be automatically created when you create a Path database 
from VDDT, and will be named as the VDDT database by default. You may rename it “Common” or 
keep the original name) into the ‘Common’ subfolder.  

 

*note that the WNE_VDDT_20110706 scenario shown in the left window of the above figure is the same 
scenario as the one renamed Common in the right window. This scenario contains the models. 

6. Double click on the ‘Common’ scenario and specify model parameters with the following 
information: 

a. Summary tab – leave this as is, unless you want to write notes in the author or description 
field 

b. General tab (figure below) 
i. Timesteps: ILAP forests=300 years, ILAP arid=150yrs 
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1. Note: regardless of length, the MCM file (discussed later) must be at least 
this long or greater or the MCM multipliers will not be applied for the full 
simulation length 

ii. Number runs (simulations):ILAP=30  
iii. Resolution: ILAP=200 (approximately 10 acres) 
iv. Remove any information from the “total area” field 
v. For tutorial data only: Change the # simulations in the Common scenario from 30 to 

3 and duration to 100 years. Along with the tutorial’s selection of just two 
watersheds within the WNE model region (created from the tutorial spatial data 
layer’s “RegionMask_ForTutorial”), this will change processing time from 24+ hrs to 
approximately 30 minutes. 

Figure: Common-Scenario’s, general parameters used by ILAP (v3.0 left, 3.1 right) 

 

c. Transitions tab – This holds all the models; leave as is 
d. Treatments tab – Make sure this is blank.  Right click in the Treatment Details window to 

delete all, if necessary 
e. Time Since Transition Groups – leave anything in this tab as is 
f. Advanced tab 

i. Make sure nothing is in Initial Conditions tab.  Right click to delete all if necessary. If 
there are values, it is OK because the values within the individual modeling strata 
will take precedence over the values in the common file, when dependencies are 
created with the GIP tool (next section). 

ii. Make sure nothing is in Transition Multipliers tab.  Right click to delete all if 
necessary. 

iii. We do not use state attribute values, but if something is listed here you can keep it 
or delete it 

iv. We do not use fire history – right click to delete all, if necessary. 
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v. Fire transition groups are only used with fire history – right click to delete all, if 
necessary. 

vi. If there is anything in the Time Since Transition Randomization, you can keep it or 
delete it. 

vii. VDDT Multipliers (figure below) 
1. Add the Monte Carlo Multipliers (MCM) file to the VDDT Settings->VDDT 

Multipliers options window.  

 

viii. Set the VDDT Outputs under Output Options (figure below) 
1. Output Control 

a. Save output in VDDT CSV format and retain intermediate VDDT 
model database (v3.1:”Save intermediate output in csv format”) 

2. Summary Output 
a.  ‘State classes every’  Have Path write to file every 1 Timesteps 
b.  ‘Transitions by state class every’  Have Path write to file every 1 

Timesteps 
g. Data Sources tab 

i. This can be used to double check which parameters are in each scenario.  Nothing 
needs to be changed here unless you catch an error 

7. Set the output directory for output .csv files in the main window of Path under File-Preferences-
VDDT-Folder for VDDT Model Output.  Specify the Path_Output/Output_Date folder in the rollup file 
structure. 

8. Save the Path database and close Path. 

Figure: Common-Scenario’s, Advanced-Output used by ILAP (v3.0 left, 3.1 right) 
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Get Into Path: The GIP tool 
The next step in the modeling process is to use the Get Into Path (GiP) tool to populate the Path 
database that you will use to run the models (Figure below). This tool automatically uploads the strata 
(unique combinations of Watershed-PVT-Ownership) found in each modeling region (and which should 
now be in your rollup database) and their associated transition multipliers into Path. This creates in a 
Path Db: 

• Individual Path Multipliers-scenarios 
• Individual Path Runs-scenarios 
• The dependencies between the Common-scenario, the Multipliers-scenarios and the Run- 

scenarios. 

Figure: “TemplateForPath” Path Db vs. the post-GIP Path Db 
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1. Open the GIP tool (Tools/GIP_Tool) 
a. Browse for and select the rollup database 

(Tools/DataDataRollup_Tools/DataRollup_Database/) 
b. Set the spatial resolution. ILAP data uses a resolution of 30 meters. This resolution requires 

the same resolution that was used in the Rollup GIS tool and should be the same as the 
resolution as your GIS data.  It is extremely important to get the correct resolution, 
otherwise final acreages will be wrong.  

c. Select the management code field (“owner_id”).  
d. Select the multiplier table (the newly-created, “TransitionMultipliers” in the Data Rollup 

Tool database).  
e. Select the file name and location of the existing or newly-created, Path template DB (e.g.  

Models/TemplateForPath_WNE_Path_Forest_YYYYMMDD).  
f. Select a name and location for your Path DB that will be created by the GIP tool. (e.g. 

Models/ “WNE_Path_Forest_YYYYMMDD”) 

Click ‘Create Path Database’Figure: Get Into Path (GIP) tool 
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9. The GIP tool will have updated the rollup database by populating the tables, “tbl_InitCondScenarios” 
and “tbl_MultiplierScenarios” and have added that information to your new Path Db.  

10. Close GIP and open the newly created Path Db (in the Path software) 
11. Confirm that the GIP tool was successful by verifying the following: 

a. The MCM file and Output options have been set in the Common Scenario (and update if 
information is still missing). 

b.  Transition multipliers exist in the Multipliers folder 
c. Modeling strata have been added to the Runs folder  
d. Dependencies for the Common file and the Multipliers have been added to the individual 

modeling strata. If you open an individual modeling strata in the Runs folder, you will notice 
that any values that are provided by dependencies are greyed out (figure below). This 
indicates that you can’t change these options within the modeling strata but must change 
the dependent files themselves: either the Common scenario or the strata-related Multiplier 
scenario. Also note that the general parameters of #runs, #simulations and resolution are 
not greyed out. This indicates that these values are not part of the Common scenario’s 
dependency and if you desire to make changes to those values, you must either rerun the 
GIP tool or change those values in every individual modeling strata. This also means that 



 

21 
 
 

changing the values in the Common scenario after the post-GIP PathDb has been created 
will not change the values in the individual modeling strata at runtime! 

Figure: Path modeling strata with MCM location and multiplier values greyed out because they are part 
of a dependency (top). The general parameters are set within each modeling strata (indicated by black 
lettering). 

 

12. Under File->Preferences, choose a new folder location for your scenario runs (e.g. 
Path_Output\Output_YYYYMMDD). Save your Path DB and close the software.  

13. Make a backup copy of your newly-created Path DB (e.g. “Path_...._backup.mdb”). This is so that if 
there are errors in running Path scenarios, the user can discard this “polluted” Db and recopy the 
from the backup Db. 
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Running models in Path 
Your Path Db should now be ready for running simulations. Because of the size of ILAP model regions 
and the number of strata that need to be run this process will likely take several days. The results are 
written to hundreds of individual output folders which will need to be merged together before viewing 
the results for the entire region. If you are OK with running the full set of strata in your Path Db, then 
follow the steps below. In Path 3.x there is a memory leak which will cause Path to crash during a model 
run if the steps below are not exactly followed. It is unknown whether this issue was resolved for Path 
4.x 

1. Reboot your computer.  

2. Open Path. 

3. If you haven’t done so already, make a backup of your Path Db, set the output directory, the 
location of the MCM file and save the Path Db. 

4. From the Runs folder, select up to 300 run scenarios at a time that you want to run, right click 
and select “Run”. In the example, 3 scenarios have been selected. One scenario [227] was run 
already and has a check mark by it.  

Figure:  The Path Explorer and Task Monitor showing scenarios being run. 
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5. Save your database after these 300 scenarios have been run and close the software. Shutdown 
your computer, restart (cold-boot) and re-open Path. 

6. Select the next 300 scenarios and run. Repeat these steps 5&6 until all scenarios have been run. 

7. If there was an interruption at any point in the scenario runs, you need to be aware that Path 
may try to run several scenarios before stopping. Check the previous output files and delete the 
Results file from the Results folder for theaborted runs. These aborted run files should also have 
an “exclamation” icon next to their file names in Path. Make sure these aborted scenarios are 
also deleted in your file system (the output folders containing the .csv output within Windows 
Explorer). Otherwise, the summarization tool (next section) will not work. 

8. After running models in Path, the database size will expand dramatically. This is occurs even if 
you do not save results inside Path. After a complete run, you should always open the Path Db 
and choose Manage>Compact and Repair. This will de-fragment your Db and reduce the size. 
For example, the tutorial Db went from 300MB to 40MB after compacting. You can optionally 
change a setting in Access to automatically “compact and repair” every time a Db is closed. 

Summarize outputs in R 
Output from the Path model runs is saved outside of the Path interface as comma separated variable 
(csv) files. There is both a transitions summary and a states summary csv file created as output for each 
of the Run-scenarios, which means there could be hundreds to a thousand-plus files that a user must 
manage and view the results for. This step combines the output from each of the run-scenarios into a 
single csv file.  
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1. Close the Path project. 
2. Launch the R program 
3. Install the package in R from the menu item: Packages > Install from local zipped file. Navigate to 

the Tools\Summarization_Tool\RCode folder and select the SumPath_0.10.zip file. 
4. Copy the following lines of code into Notepad (or any text editor) and change the two pathways 

to match the directory and file names on your computer. Make sure to change any single 
backslashe (from Windows file system) to two backslashes or one forward slashes in the paths 
you just inserted. The example below uses two backslashes. Keep the quotes around the 
pathname for the output folders and Path database. 

library(SumPath) 
setwd("D:\\DIRECTORY_PATH_CONTAINING_YOUR_PATH_OUTPUT_FOLDERS") 
scenariolist<-GetLinks("D:\\FULL_PATH_TO_YOUR_PATH_DATABASE") 

SummarizeScenarios(scenariolist, tablename = "ClassesSummary.csv", 
sumcols = "ClassCode", replace.existing = F, quiet = F, return.to.r = 
F) 
 

SummarizeScenarios(scenariolist,tablename = 
"TransitionsByClassesSummary.csv", sumcols = c("TransTypeCode"), 
replace.existing = F, quiet = F) 

 

5. Select all (ctrl+A) and copy (crtl+C) 
6. At the R command line, paste this code (Ctrl+V) and enter to run 
7. The code will pause almost immediately and normally you should just press <enter> to proceed. 

This code automatically deletes data from previous summarizations so it pauses to allow you to 
change your mind and either change your pathways or save this previously summarized data 
somewhere else.  

8. A summarized output file for both transitions 
(“TransitionsByClassesSummaryTransTypeCode.csv”) and states 
(“ClassesSummaryClassCode.csv”) will be created in your Model_Output/ Output_YYYYMMDD 
folder. This process may take a couple hours for an entire model region. For the tutorial results, 
this will take approximately 10 minutes. 

9. To see help on the SumPath package, type help(SumPath) at the R prompt 
 

Graph the Classes Summary file in Excel 
Path allows the scenario results for state classes to be written to an individual csv file. However, once 
these individual csv files are summarized into a single csv file, they may be too large to open in Excel. 
Also, only the most basic information is supplied in the summarized csv file. There are no descriptive 
fields or fields that allow a user to group the summary results for more meaningful interpretations. This 
Excel-based graphing tool allows the user to graph the results (or grouped results) of the summarized 
csv file in Excel. 
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 Follow the steps below or the powerpoint readme file for instructions on using this tool. 

1. Rename your summarized class code file from Model_Output/ Output_YYYYMMDD/ 
“ClassesSummaryClassCode.csv” to “StatesSummary.csv”.  Alternatively, you can also make a 
copy of the summary file and move to any location on your computer before renaming to 
“StateSummary.csv”. 

2. Open the graphing tool database (Tools/SummaryGraphing_Tool/). This Db contains the 
summarized csv file, tables that link summary codes with descriptive names and the pre-built 
queries, which Excel runs to create the pivot table. 

3. Reset the location of the linked summary table to the newly-generated, summarized csv file in 
your Path_Output folder 

a. Right click on the StateSummary file and choose Linked Table Manager 
b. Check both boxes in the LTManager window (figure below) and browse and navigate to 

your new file. 
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4. Open the Excel graphing tool 
(Tools/SummaryGraphing_Tool/Run_Graph_ClassesSummaryClassCode.xlsm) 

5. When this tool is first opened, a form provides the user chooses such as region of interest, 
timestep intervals and the type of grouping. However, if this form does not automatically open, 
security settings need to be changed in Excel: 

a. Excel OfficeButton(top left)>Excel options>Trust Center> Trust Center Settings>Macro 
Settings>Change to disable macros with notification (Figure below)(“Enable all macros” 
would be preferable so you won’t have to keep re-doing step 6 every time you need to 
run the tool. However, there may be a slight risk of exposure to malicious macros if a 
user was to download an Excel file from an unknown source.) 

 

6. Save the Excel file, close and re-open. If the form still does not open: 
a. Select “Options” from the security ribbon 
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b. Select “Enable this content” and OK. The form should now pop-up automatically (but 
you will probably need to re-do this step every time you open this Excel file). 

 

7. Select the options for this tool and choose “Create Pivot Chart” to run. If there are errors, then it 
is likely that some “references” need to be loaded in Excel (figure below)(this will be a one-time 
update to the Excel software (not the specific file) on your computer): 

a. In the VBA module, Select Tools->References 
b. If there are references at the top of the dialog box that are checked but begin with 

“MISSING…”,  then uncheck them before proceeding. 
c. Browse for and check the following to references 
d. Microsft ADO ext. 2.8 for DDL and Security (or highest version)  
e. Microsoft ActiveX Data Objects 2.7 Library (or highest version) 
f. Click OK 
g. Then Save and close Excel , then re-open and rerun the form 

 

8. Once the tool is run, a pivot table is built in Excel and a graph is automatically generated based 
on this table. This pre-built graph can be changed to suit the user’s needs based on any of the 
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information available in the pivot table.  For example, results can be filtered by watershed or 
PVT. Also, a new chart of a different type can be built from the pivot table. 

9. Save this pivot table and chart as a new sheet in the graphing tool or as a new Excel file. The 
next time the tool is run, it will ask you to delete the previously-created pivot sheet. 

Additional graphing notes 

Confirm that all your results are being reported by examining the summarized area (far right column in 
the pivot table beneath the chart) across all timesteps. If the area changes (by more than a few acres) 
then it is possible that the master codes crosswalk (r6_classcodes, r6_classcodes_nf, r3_classcodes or 
r3_classcodes_nf) inside the graphing database (e.g., Tools/SummaryGraphing_Tool/ 
Graph_ClassesSummaryClassCode.mdb) does not contain the entire list of states used by your models. 
Add new records to the crosswalk to rectify this error. This will only occur if you or someone else has 
added new states to the ILAP models (that were completed at the end of 2011). 

If you want to use different groups from what is currently available in the “ClassCodes” tables, then 
replace the values in one of the grouping fields with your own. Do not change the name of the field. The 
grouping fields are at the end of each master codes table. 

 

Appendix-Advanced Section 
Lumping Strata (optional) 
Our state-and-transition models do not yield stable results when the number of pixels in a modeling 
stratum (run-scenario) is too small.  Wherever possible, we reassign pixels from a small stratum (<1,000 
acres) to a larger, similar stratum within the same HUC.  This reassignment is based on similarities in PVT 
(using elevation, moisture regimes, species composition and ownership-allocation). When there is no 
reasonable reassignment, any remaining, small strata are excluded from the rollup into the Path Db. 

Create a template strata aggregation table 
1. Run the auxillary tool within DRQT to generate a strata table for aggregation (lumping). In this 

new dialogue box (File > Build strata table for aggregation…): 
a. Select the rollup database (e.g., DataRollup_WNE_YYYYMMDD.mdb) 
b. Select the PVT field (“PVTCode” in R6), the HUC field (“Value_”) and the Owner field 

(“Owner_ID”) 
c. Select “Create Data” 
d. This creates a table,”tbl_rollupStrata” that is later referenced in the R-code, 

“LumpStrata”.  
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To lump fragments we have two methods. One method is used for the Pacific Northwest only at the 
writing of this document, and the other is used only for the southwest Region 3. Both methods create a 
“strata aggregation table”.  

Region 3 Lumping:  Lumping with the LumpStrata library in R 
1. Install the LumpStrata package in R using the Packages menu > Install package(s) from local zip 

files… 

 

2. Access the LumpStrata functions by loading the library 
> library(LumpStrata) 
> help(LumpStrata) 

 
3. Set your working directory 

> setwd("D:/WORK/ACP/Lumping") 
4. Load the R3 data included in the package for the pvtindset and mgtindset 

> data(mgtindset.forest)     
or 

> data(mgtindset.woodland) 
or 

> data(mgtindset.arid)       
and  

> data(pvtindset) 
5. Import the strata table to R from the rollup database to the object “StrataTable”. Make sure that 

you include the path to your rollup database. 
> StrataTable<-
GetStrataTable("D:/temp/NRM_Forest_dataRollupTool_v3061711.mdb") # 
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change the directory to match your directory structure and the name 
of your DataRollup database 

6. To see what the R3 index sets look like, use the PrintSimMat function 
> PrintSimMat(mgtindset.forest) or 
> PrintSimMat(mgtindset.woodland) or 
> PrintSimMat(mgtindset.arid)   
 
> PrintSimMat(pvtindset[grepl("AMT",pvtindset[,1]) & grepl("AMT", 
pvtindset[,2]),])[[2]]  # customize for your region by replacing 
“AMT” with your modeling region code. 

7. Finally, execute the lumping function, LumpStrata. The only thing that you may wish to change 
at this step is the output .CSV file name. 

> LumpStrata(StrataTable,pvtindset,mgtindset.xxxx, outfilename = 
"temp.csv") # use the mgtindset that matches your model type (arid, 
forest, woodland) 

 

Region 6 Lumping:  Lumping with the Lumping functions in R 

 

1. Lumping:  lumping using Emilie’s lumping codes that will require you to navigate to ArcInfo and 
ArcGIS world. This produces the strata aggregation table referenced in the VDDT Data Rollup 
Tool Step 3.  

a. GIS Directory and Files 
i. Create an ArcInfo workspace (directory) for ArcGIS Grid files (e.g. 

Rollup\Lumping\ArcInfoTemp) 
ii. In ArcMap, add the PVT grid from your rollup DB  

1. add a new field (e.g. “newVal” and copy the ObjectId values to this new 
field (so that the new field has  consecutive #’s from 1 to the # of PVTs) 

2. if there are PVT codes that are “na” (or otherwise not used in VDDT), 
recode these values to zero. 

3. Open the table for the grid and export this as a dbf, “pvt_lut.dbf” to the 
“lumping” folder 

4. use the Lookup tool (Spatial analyst tool>Reclass>Lookup) to create a 
new grid based on this new value field, saving the ouput raster as, “pvt” 
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to your ArcInfo workspace in the “lumping” folder

 
iii. Export a DEM (does not need to be clipped to model region) to a Grid into this 

workspace as, “dem” 
iv. Add the GNN Basal Area attributes table 

(Rollup\Databases\R6_GNN_BasalArea.mdb) and join to the fGDB’s GNN layer 

 Note:  If you are using the full GNN table (GNN_attributes.dbf) to the GNN grid, you will need to 
remove the duplicate field, “Imap_Layer_1” and copy and overwrite previous GNN grid. It’s also 
possible that you’ll have to remove other fields if the list is too long. In this case, keep the *_BA 
fields. You can use the ArcTool Data Management Tools > Fields > Delete Field to drop multiple 
fields.  

v. Export this joined GNN layer to a Grid into this workspace as, “gnn” 
vi. Add the AML files, pvt_gnn.aml and cleanupdir.aml to this workspace if you 

haven’t already. 
b. Create the Species Matrix (“pvt_gnn.csv”) 

Note:  The R code uses the basal area (*BA) fields in the GNN table to create the species matrix.  

Purpose:  The species matrix supplies information on the kinds of vegetation that 
are found in each PVT and uses this information to help identify similarities in the 
lumping process. 

i. Add the pvt_gnn.aml and cleanupdir.aml AML files to the Rollup Strata folder 
(see image below) 

ii. Create a csv file based on the “pvt_lut.dbf” 
a. Open the dbf and delete all fields except the PVTCode and your newly 

created, new value field 
b. Delete the records with zero values (i.e. “na” PVTs) 
c. Save this as a csv in the same folder (e.g. “pvt_lut.csv”) 

iii. Navigate to this new, ArcInfo directory within an ArcInfo command prompt 
and then run the first aml by typing, “&r pvt_gnn.aml [pvtgrid] [gnngrid] 
[#ofPVTs in your region]” (e.g. “&r pvt_gnn.aml pvt gnn 4”) (see document, 
“readme-pvt_gnn.aml” for detailed instructions)…this creates a species matrix 
for each PVT as the first of 3 parts for determining similarity between PVTs 

c. Create an Environmental Similarity matrix (“pvt_attributes.csv”) 



 

32 
 
 

Purpose:  The ES matrix helps identify similar PVTs in the lumping process using the 
elevation range extremes determined through zonal statistics analysis in GRID. This 
matrix contains information that is used in developing an index of similarity among 
all of the PVT's present in a given modeling region. The file 'pvt_attributes.csv' 
contains information that is used in developing an index of similarity among all of 
the PVT's present in a given modeling region. 

i. Store the ES matrix in a file called 'pvt_attributes.csv' (see “readme-
pvt_attributes.txt” for the detailed instructions).  

ii. Copy and paste the “template_pvt_attributes.csv” (e.g. 
pvt_attributes_WNE_YYYYMMDD .csv) and the pvtcode value from your 
region’s  pvt_lut.csv into the first field. Generate and export the elevation min 
and max for each pvt in the PVT grid in ArcWorkstation, using the ArcInfo 
commands  below: 

a. > w YOURWORKINGDIRECTORY 
b. > Grid 
c. > summary1.dat = zonalstats(pvt,dem) 
d. > quit 
e. > infodbase summary1.dat summary1.dbf 

 

iii. Use the summary1.dbf to fill in the “ElevMin” and “ElevMax” values in your 
region’s “PVT_attribute.csv” file (or estimated by the user if either PVT map, 
or elevation map is missing) Important Note: The summary1.dbf gives output 
related to the PVT Grid values whereas the ID’s from the VDDT DB are 
automatically assigned to the PVT’s as they are imported into the DB. You 
must find the PVT_code that corresponds to the Grid values (presented in the 
Summary.dbf) and match those to the PVT_code-to-VDDTId shown in the 
pvt_attribute.csv. 

iv. Classify each PVT into a moisture class (dry, intermediate, mesic, or wet) and 
fill in the Moisture field in the PVT_attribute.csv file 

v. Have this table reviewed by Miles Hemstrom or someone familiar with the 
PVTs. 

d. Identify the management treatments in the “management_attributes.csv” table as the 
third part of the lumping process by placing a 0 (does not occur) or a 1 (occurs) under 
the treatment. 

i. Copy and paste template_mgt_attributes.csv (e.g. 
mgt_attributes_WNE_YYYYMMDD.csv). Identify the management treatments 
in this new table as the third part of the lumping process by placing a 0 (does 
not occur) or a 1 (occurs) under the treatment field. 

e. Lump your strata based on the files just created 
i. open the R-code named “LumpStrata_ControllerScript.r” and change file and 

folder names before running: 
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1. main.wd<-"AddPathHere/Lumping” 
2. pvt.wd<-paste(main.wd,"/AddArcInfoWorkspaceHere" 
3. ch1<-odbcConnectAccess("AddPathHere/Rollup/Databases/AddInitCond-

DRT.mdbHere ") 
4. StrataTable<-sqlFetch(ch1,"tbl_rollupStrata")(this is the table created by DRQT) 
5.  pvtlut<-read.csv("ChangeNameHereForpvt_lut.csv")  
6.  outfilename<-"ChangeNameHereForStrataTable.csv"  
7.  pvt.attributes<-read.csv("ChangeNameHereForpvt_attributes.csv")  
8.  mgt.attributes<-read.csv("ChangeNameHereFormgt_attributes.csv")      

ii. This will create a new file (e.g. “StrataTable_WNE_YYYYMMDD.csv”) that will 
be used in the Access rollup process. This is the strata aggregation table.  

iii. Repeat this step 3-4 times (adding an iteration number to the file name) and 
make sure the number of records is the same across runs If record number is 
the same across files then you can delete the extra file iterations, if not refer 
the problem to Emilie Henderson. 

 

Create a new multipliers table 

To create a new Transition Multiplier table, follow the steps below: 

1. Create a new table (“tempTransitionMultipliers “) from a query in your VDDT database. Set the 
query to View SQL and enter the following statement. This creates a 3-field table consisting of the 
PVT, transitions, and multipliers: 

SELECT Project.Name AS PVT, ProbabilisticTransitionType.Name AS [Transition Type], 
ProbabilisticTransitionMultipliers.Multiplier INTO tempTransitionMultipliers FROM (Project INNER JOIN 
ProbabilisticTransitionType ON Project.ProjectID = ProbabilisticTransitionType.ProjectID) INNER JOIN 
ProbabilisticTransitionMultipliers ON ProbabilisticTransitionType.ProbabilisticTransitionTypeID = 
ProbabilisticTransitionMultipliers.ProbabilisticTransitionTypeID; 

2. In this temporary multiplier table, convert any fractional multipliers to 1, using an update query: (R3 
forest, woodland and arid lands use multipliers other than 1.  If you change these without knowing 
what you’re doing, you could accidentally change the models a lot. Multipliers should only be 
changed to 1 if R6 models included these fractions into the probabilities for that transition. The 
purpose for doing this in R6 is so that R6 models will only have 1s and 0s in the multipliers field as 
this is used to turn on and off management multipliers rather than being used to adjust base 
probabilities.) 

UPDATE tempTransitionMultipliers SET tempTransitionMultipliers.Multiplier = 1 WHERE 
(((tempTransitionMultipliers.Multiplier)>0)); 

3. Export the resulting table to Excel format, saving it in your GiP folder, and open the table in Excel. 
4. Open the DRT database and open the “ownall_final” table.  
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5. Copy the field of owner codes from the database and paste them into your newly exported table of 
PVTs, transitions, and multipliers in Excel. 

6. Re-copy the list of owner codes (in Excel) and use Paste Special to transpose the list as column 
headings in your open spreadsheet, as is pictured in the table below. 

7. Copy the multiplier values across all rows for all ownership fields 
8. Delete original, multiplier field 

Import this table into the DRT DB (as a table, “TransitionMultipliers”) and allow Access to add primary 
key field called, “ID” ( see field descrips and image below) 

 

 

Troubleshooting 

 

Resolving Errors in DRQT 

Two errors may occur at this point. First, the structural codes in the VDDT DB may not match the 
structural codes in the rollup DB. Second, after lumping your ForTypIV-Cover crosswalk may not match. 

• Error#1: Structural codes not matching. You’ll need to update the DRT database to 
match your VDDT database and the R6_codes master database of codes 
• Import the MasterStructureCode table from the R6_Codes DB (in 

Lumping/Databases)into your VDDT DB 
• Create the query shown below to identify the missing records in the Initial 

Conditions DB 
• Add these values to the rollup DB 

 

 

Figure 6. Error message that will 
appear if your DRT database does 
not have all of the structure 
codes found in your VDDT 
models. 
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Figure 7. Used this query to 
identify missing structure codes 
in the DRT MasterStructureCodes 
table 

 

Figure 8. Example of missing 
structure codes 

 

• Error#2: Missing entries in ForTypIV-Cover crosswalk (Forests only).  
o After lumping, this crosswalk may have new conditions that were not found in the 

initial crosswalk. The current workaround is to add these manually, each time DRQT 
throws an error: 
 Run DRQT to get an error message that states the missing ForType-Cover 

record found within a specific PVT 
 Copy the original crosswalk (in the data rollup DB) and rename this as a 

backup file (e.g. “…Crosswalk_PreLumping”) 
 In your crosswalk table, create a new record with the PVT code and 

ForTypIV value from the error message. Add a cover value from your 
options for that PVT. 

 Rerun DRQT and repeat these steps until you stop getting error messages 
(for southwest OR, there were 25 new records that needed to be created 
after lumping) 
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